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3.2 Menu Bar (Spectrum Application)
3.3 [Spectrum Mesurement Parameters] Window
3.4 Graph View
3.5 Data Processing View

3.1 Window Layout
The spectrum application has two modes consisting of "measurement mode" and "view mode".
Clicking [Measurement] on the main toolbar changes to measurement mode and clicking [View] changes to view
mode, which is used for offline tasks such as data analysis.
To edit spectrum report files or print using any created layout, click [Edit Printform] on the toolbar.

■Measurement mode

Window Layout of the Spectrum Application (Measurement Mode)

No.

Name

Spectrum
measurement
toolbar

Function
The buttons used for starting and stopping measurement and performing
instrument control are located on this toolbar.
Clicking
enables

Photometer status

(Connect) and establishing a connection with the instrument
(Start) and other buttons.

The upper section displays the current wavelength and fluorescence intensity and
the lower section displays the status of the spectrofluorophotometer.
"2.7 Photometer Status"
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Parameter view

Displays the settings of the currently configured measurement parameters (settings
such as parameters related to measurement and whether to perform automatic
printing).
This view is used to configure, save, and load measurement parameters.
"2.8 Parameter View"

Displays a spectrum graph in real time during measurement. Only [Overlay] is
available as the graph display method.
Graph view

"3.4 Graph View"

The display of the spectrum graph is toggled in the tree view.
"2.4.1 Spectrum/3D Spectrum/Time Course Applications"

■View mode

Window Layout of the Spectrum Application (View Mode)

No.

Name

Parameter view

Function
Displays measurement parameter information, data history, and summary
information (such as sample information and instrument information) of the active
data.
"2.8 Parameter View"

Displays a spectrum graph of the loaded data. [Active] and [Overlay] are available
as the graph display methods.
Graph view

"3.4 Graph View"

The display of the spectrum graph is toggled in the tree view.
"2.4.1 Spectrum/3D Spectrum/Time Course Applications"

Data processing
view

Displays the parameter setting window for the peak pick result table, point pick
result table, and data operations.
"3.5 Data Processing View"

■Edit print form
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Window Layout of the Spectrum Application (Edit Print Form)

No.

Name

Function

Print form editing
area

Edit properties such as position and size of printable objects placed on a report.

Properties view

Displays the properties of printable objects selected in the print form editing area.
Properties such as link settings and text font can be changed.

Objects list (for
printing)

Displays the printable objects that can be used in tree format.
Either double-click on object names or drag object names into the print form
editing area to add printable objects to a report file.
"9.3 Printable Objects"

3.2 Menu Bar (Spectrum Application)
l
l
l
l
l
l
l
l

3.2.1 [File] Menu
3.2.2 [Edit] Menu
3.2.3 [View] Menu
3.2.4 [Graph] Menu
3.2.5 [Instrument] Menu
3.2.6 [Tools] Menu
3.2.7 [Window] Menu
3.2.8 [Help] Menu

3.2.1 [File] Menu
Command

Description
Open a saved file.

[Open]

• [Measurement] mode: Data, Parameters, Text Data
• [View] mode: Data, Parameters, Template, Text Data
"1.2 File Types"

[Data]

Open a spectrum data file (.fs2f) or RFPC file (.spc).
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Open a spectrum measurement parameters file (.fm2f).
This type of file can also be opened with [Load] in the parameter view.

Open a point pick template (.fstp) or area calculation template (.fsta).
[Template]

This menu command is enabled when a point pick table or area
calculation table is displayed in the data processing view.
Open a text file (.txt, .csv) and convert it to spectrum data.
Data that contains pairs of wavelength and fluorescence intensity with equal intervals
(in terms of wavelength) can be opened.

[Text Data]

[Close]
[Close All]
[Save]

[Save As]

Each wavelength and fluorescence intensity must be delimited
using a comma, tab, space, semicolon, or other recognizable
character.
Close the data file that contains the active data set.
"2.4.3 Active Data Set"

Close all currently open data files.
Save the data file that contains the active data set by overwriting.
"2.4.3 Active Data Set"

Specify a filename and save a file such as a data file or measurement parameter file.
- [Measurement] mode: Data, measurement parameters
- [View] mode: Data, templates, data processing tables

[Data]

Save a data file (.fs2f). The file targeted for saving is the data file that contains the
active data set.

[Parameters]

Save the settings configured in the parameter view of the measurement mode window
to a measurement parameters file (.fm2f).

[Template]

Create a template (.fstp/.fsta) from the point pick table or area calculation table in the
data processing view and save it to file.

[Data Table]

Save the data processing result table for data print, point pick, peak pick, area
calculation, or batch point pick in the data processing view to a text file (.txt).

[Save All]

[Text File Output]

Save all unsaved data files that are open by overwriting.
Extract the spectrum data of the active data set and save it to a text file (.txt) or CSV
file (.csv).
The format and conversion conditions for text file output are set via [User Settings] on
the [Tools] menu.
"[User Setting] window (common)"

(Recent File)

The three most recently opened files are displayed.

[Properties]

Display the [File Properties] window. This window is used to check data information
and perform operations such as renaming data sets.
"[File Properties] window"

[Print Preview]
[Print]
[Exit]

Display a preview of printer output.
Print the report file linked to the currently active view.
"[Quick Print] tab"

Exit the spectrum application and close the window.

■[File Properties] window
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[File Properties] Window

No.

Item

Description
Displays the currently loaded data files in tree format. Click on a filename
or data set name to select the target for checking data information or
renaming. The selected filename or data set name is highlighted.

Data list

Data
information

-

[Parameters]

Displays the settings of various parameters at the time of data capture.

[History]

Displays the history of processing (data processing, renaming, etc.)
performed on the data set from the time of creation to its current state.

[Summary]

Displays details including sample information entered at measurement
(sample name and comments) and information on the instrument used
(instrument name and serial number).
Delete a data set from the file. This is used to delete data sets that are no
longer needed, such as data sets created in data operations.

[Delete]

Change a data set name or sample information.
-

[Rename]

-

[Close]

The filename cannot be changed.
Close the [File Properties] window.

3.2.2 [Edit] Menu
"2.2.1 [Edit] Menu"

3.2.3 [View] Menu
"2.2.2 [View] Menu"

3.2.4 [Graph] Menu
Measurement mode
Command
[Cursor]
[None]

Description
Select the cursor type to display on graphs.
A normal cursor is displayed (default).
Displays a cursor with an intersecting vertical and horizontal line. The intersecting
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[Crosshairs]

point is moved in the graph view using the mouse and the coordinates are displayed
on both scales.

[Auto Scale]

Adjust the scale automatically based on the data.

[Customize]

Display the [Customize Graph] window. This window is used to set the display
conditions for graphs.
"[Customize Graph] window"

View mode
Command

Description

[Active]/[Overlay]

Toggles between the graph view tabs ([Active] and [Overlay]).

[Cursor]

Select the cursor type to display on graphs.

[None]

A normal cursor is displayed (default).

[Crosshairs]

Displays a cursor with an intersecting vertical and horizontal line. The intersecting
point is moved in the graph view using the mouse and the coordinates are displayed
on both scales.

[Surfing]

Displays a cursor with an intersecting vertical and horizontal line. The intersecting
point is moved across active graph using the mouse and the coordinates are displayed
on both scales.
This can only be selected when [Active] is selected in the graph view.

[Auto Scale]

Adjust the scale automatically based on the data.

[Customize]

Display the [Customize Graph] window. This window is used to set the display
conditions for graphs.
"[Customize Graph] window"

■[Customize Graph] window
[Line Colors] tab

[Customize Graph] Window - [Line Colors] Tab

Item

Description

[Data]

Displays a list of the currently open data sets. The current annotation, line type, and
line color are indicated to the left of the data set name. The selected data set name is
highlighted.

[Annotation]

Select the display style of the annotation used to display data points.
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[Line]

Select the graph line from types such as solid line and dotted line.

[Width]

Set the width of the graph line.

[Basic Color]

Displays the colors that can be used as the graph line color. Selecting the target data
set under [Data] and clicking a color in the pallet changes the spectrum graph line
color.

[Created Color]

Displays the colors created using [Create Color].

[Create Color]

Display the [Create Color] window. This window is used to create colors absent from
the basic color pallet.
Display the default line colors in the [Data] list. To change the default line colors,
select the line to change in the list and then select a color from either the [Basic
Color] or [Created Color] pallet. Clicking on [Defaults] changes the button name to
[Data]. Clicking [Data] returns to the original display.

[Defaults]

This is displayed when [Overlay] is selected in the graph view.
[OK]

Close the [Customize Graph] window and redisplay the graph view based on the
settings made.

[Cancel]

Cancel any settings made and close the [Customize Graph] window.

[Limits] tab

[Customize Graph] Window - [Limits] Tab

Item

Description

[X Axis]

Set the upper and lower limit values of the X axis on the graph.

[Y Axis]

Set the upper and lower limit values of the Y axis on the graph.

[Auto Scale]

Set the axis to undergo automatic scaling and the conditions of execution. For
example, entering "10" into the [Percentage] field for the Y axis will perform
automatic scaling in the state where a margin equal to 10 percent of the entire
measurement data is used on the upper and lower ends of the Y axis.

[Appearance] tab
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[Customize Graph] Window - [Appearance] Tab

Item

[Area To Be Specified]

Description
Select the item whose appearance is to be set. Selecting an item enables any
configurable settings, such as color and font.
Selection options: "Axis Labels, and Graph Title," "Background", and "Grid, Tick
Marks, and Frame"

[Settings] tab

[Customize Graph] Window - [Settings] Tab

Item

Description
Set the grid style.
Selection options: None, Major, Major & Minor

[Style]

• [Major] displays a grid of only the major tick marks.
• [Major & Minor] displays a grid of the major tick marks and minor tick
marks. This setting is enabled when the [Minor Tick Marks] checkbox is
selected.
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[Round Tick Marks]
[Minor Tick Marks]

Select this checkbox to set tick marks to rounded values. Deselect the checkbox to set
tick marks at equal intervals.
Display minor tick marks.
This setting is enabled when the [Round Tick Marks] checkbox is selected.

3.2.5 [Instrument] Menu
"2.2.3 [Instrument] Menu"

3.2.6 [Tools] Menu
"2.2.4 [Tools] Menu"

■[User Settings] window (spectrum application)
The settings on the [Text File Formats] and [Text Output] tabs are the same for all of the basic analysis
applications.
"[User Setting] window (common)"

[General] tab

[User Settings] Window - [General] Tab

Item

Description

[Show Messages]

Select whether to display confirmation messages.

[Number of Displayed
Decimal Places]

Set the number of decimal places to show for displayed numerical data, such as graph
scale values and for data printing.

[X-Axis Value]

Select the number of decimal places for X-axis values.
Selection options: 0, 1

[Y-Axis Value]

Select the number of decimal places for Y-axis values.
Selection options: 0 to 3
Select the format of data set names for printing and display in the data processing
table.

[Data Display Format]

• Data Set Name
• Full Path - Data Set Name
• Filename - Data Set Name
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• Data Set Name - Full Path
• Data Set Name - Filename
• Filename
• Full Path
Select this checkbox to display [RawData] in the tree view.
[Show RawData]

This setting is available when connecting to the RF-6000 series.

[Quick Print] tab

[User Settings] Window - [Quick Print] Tab

Item
[Print Item]

Description
Displays the views and data tables that can be linked to report files.
[Measurement Parameters] refers to the parameter view of the [View] menu.

[Report File]

Clicking an item in the [Print Item] list selects it and displays the name and save
destination of the report file to which it is linked.

[Browse]

Display the report file selection window.

[Reset]

Return links to their initial state.

[Links] tab
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[User Settings] Window - [Links] Tab

Item

Description

[Link Description]

Displays link items (active spectrum, overlay etc.) for setting to reports.

[Data Set]

Displays the data sets corresponding to the [Link Description] items. For example,
when quick printing a report that contains a graph object set with "spectrum data 1",
this column allows you to check which data set graph will be printed.

3.2.7 [Window] Menu
"2.2.5 [Window] Menu"

3.2.8 [Help] Menu
"2.2.6 [Help] Menu"

3.3 [Spectrum Mesurement Parameters] Window
■[Measurement] tab
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[Spectrum Mesurement Parameters] Window - [Measurement] Tab

Item

Description
Select the spectrum type.
• [Emission]: Measure the specified fluorescence wavelength range while keeping
the excitation wavelength fixed.
• [Excitation]: Measure the specified excitation wavelength range while keeping the
fluorescence wavelength fixed.

[Spectrum Type]

• [Synchronous]: Measure the specified ranges while moving the excitation
wavelength and fluorescence wavelength.
In synchronized scanning, the excitation wavelength moves by the same
wavelength width as for the fluorescence wavelength scan range.
For example, when the start wavelength is set to 400 nm on the excitation side
and the scan range on the emission side is set to 500 to 800 nm, the excitation
wavelength measurement range is 400 to 700 nm (the data interval is the same
as that set for the emission side).

[Excitation]/
[Emission]

Set the wavelengths to measure, wavelength range, and data interval.

[Wavelength]

Enter the wavelength to measure.
Effective range: 220.0 to 900.0 (RF-5300 series), 200.0 to 900.0 (RF-6000 series)

[Start]/
[End]

Enter the wavelengths to measure.
Effective range: 220.0 to 900.0 (RF-5300 series), 200.0 to 900.0 (RF-6000 series)
Select a data interval. Selection options differ depending on the instrument model and
configured scan speed.

[Data Interval]

"3.3.1 Scan Speed and Data Interval"

If the set wavelength range is not divisible with the set data interval, measurement
ends at the data point before the end wavelength.
[Scan Speed]
[Perform Auto Print]

[Report File]

Select the scan speed. Selection options differ depending on the instrument model.
"3.3.1 Scan Speed and Data Interval"

Select this checkbox to perform printing automatically after measurement using the
specified report file.
Enter the full path of the report file to use for automatic printing.
The report file can also be selected by clicking
.
This field is enabled when the [Perform Auto Print] checkbox is selected.

[Save As]

Save the settings as a measurement parameters file.

[OK]

Confirm the settings made and close the [Spectrum Mesurement Parameters] window.
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[Cancel]

Cancel the settings made and close the [Spectrum Mesurement Parameters] window.

■[Instrument] tab
RF-5300 series

[Spectrum Mesurement Parameters] Window - [Instrument] Tab

Item

[Spectral
Bandwidth/Excitation]

[Spectral
Bandwidth/Emission]

[Sensitivity]

Description
Set the spectral bandwidth of the excitation side monochromator.
Selection options: 1.5 nm, 3.0 nm, 5.0 nm, 10.0 nm, 15.0 nm, 20.0 nm, 6HH
[6HH] is a half-height slit (spectral bandwidth is 6 nm). This setting is used
when measuring solid samples.

Set the spectral bandwidth of the emission side monochromator.
Selection options: 1.5 nm, 3.0 nm, 5.0 nm, 10.0 nm, 15.0 nm, 20.0 nm, Close
Light is not received by the emission monochromator when [Close] is selected.

Set the sensitivity.
Selection options: High, Low
[High] is approximately 50 times more sensitive than [Low].

[Response]

Set the response speed of the RF-5300PC with respect to changes in the fluorescence
intensity of the sample.
Although lower values allow tracking of rapid changes in fluorescence intensity, such
values will increase noise. On the other hand, although higher values cannot track
rapid changes in fluorescence intensity, such values will reduce noise.
Selection options: 0.02s, 0.03s, 0.1s, 0.25s, 0.5s, 2.0s, 4.0s, 8.0s, Auto
• Selecting [Auto] automatically sets the optimal response value with respect
to the scan speed that prevents the peak position from shifting.
• When [Scan Speed] is set to [Survey] on the [Measurement] tab, the
response value is automatically set to 0.02 seconds and this value cannot be
changed.

RF-6000 series
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[Spectrum Mesurement Parameters] Window - [Instrument] Tab

Item

Description

[Spectral
Bandwidth/Excitation]

Set the spectral bandwidth of the excitation side monochromator.
Selection options: 1.5 nm, 3.0 nm、5.0 nm、10.0 nm、15.0 nm、20.0 nm

[Spectral
Bandwidth/Emission]

Set the spectral bandwidth of the emission side monochromator.
Selection options: 1.0 nm, 3.0 nm、5.0 nm、10.0 nm、15.0 nm、20.0 nm
Set the sensitivity of the detector.
Selection options: Auto, High, Low

[Sensitivity]

Select [Auto] to automatically optimize sensitivity for measurements.
The optimal sensitivity for each wavelength is automatically recognized by prescanning before starting measurement.
This setting is for cases when the fluorescence intensity value for measurement
is not predictable or when a wavelength area to measure at one time has a large
fluorescence intensity difference. Since pre-scanning is performed before
measurement, if the sample property changes significantly fast by excitation
light irradiation, select [High] or [Low] as necessary when performing
measurement.

■[Attachment] tab

[Spectrum Mesurement Parameters] Window - [Attachment] Tab
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Item

l

Description

[Attachment] list

Select the attached device for selection.
Selection options: None, Sipper

[Sip Speed]

Select the intake speed of the sipper.
Selection options: Fast, Medium, Slow

[Sip Time]

Enter the intake time of the sipper.
Effective range: 0 to 64 seconds

[Purge Time]

Enter the discharge time of the sipper.
Effective range: 0 to 64 seconds

[Dwell Time]

Enter the stabilization time of the sipper.
Effective range: 0 to 99 seconds

[Rinses]

Enter the number of times to rinse the sipper.
Effective range: 0 to 4 times

[Sample Recovery]

Select this checkbox to return the sample to its original container (rotate the rotor in
reverse).

[Sip]

Perform a sip operation according to the configured settings.

[Purge]

Perform a purge operation according to the configured settings.

3.3.1 Scan Speed and Data Interval

3.3.1 Scan Speed and Data Interval
Some data intervals cannot be selected depending on the configured scan speed.

■RF-5300 series (P: usable, ´: unusable)
Data Interval (nm)
Scan Speed
0.2

1.0

2.0

Survey

´

´

P

Super

´

P

´

Very Fast

´

P

´

Fast

P

P

´

Medium

P

P

´

Slow

P

P

´

Very Slow

P

P

´

■RF-6000 series (P: usable, ´: unusable)
Scan
Speed

Data Interval (nm)

(nm/min)

0.1

0.2

0.5

1.0

2.0

5.0

10.0

60000

´

´

´

P

P

P

P

30000

´

´

P

P

P

P

P

12000

´

P

P

P

P

P

P

6000

P

P

P

P

P

P

P

2000

P

P

P

P

P

P

P
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600

P

P

P

P

P

P

P

200

P

P

P

P

P

P

P

60

P

P

P

P

P

P

P

20

P

P

P

P

P

P

P

3.4 Graph View
l
l

3.4.1 Measurement Mode
3.4.2 View Mode

3.4.1 Measurement Mode
The only available graph view in measurement mode is the [Overlay] tab.
Spectrum data in memory is displayed in an overlaid state in this graph area and spectrum data currently being
measured is displayed overlaid in real time.

Graph View (Measurement Mode)

■Right-click menu of the graph view (measurement mode)
Click the right mouse button on the graph view to display the following right-click menu.
• This is the same as the view mode right-click menu apart from the [Lock Cursor] menu items.
• The cursor type can be changed via [Cursor] on the [Graph] menu.

Command
[Copy]
[Picture]

Description
Copy the graph on the [Active] tab or [Overlay] tab to the clipboard.
Save a graph image in metafile format to the clipboard.
The graph can be pasted as an embedded graph object in report editing mode.

[For Report File]

An embedded graph object is an object that is not linked to the graph view
state.

Perform automatic scaling of the graph. Automatic scaling is configured on the
[Limits] tab in the [Customize Graph] window.
[Auto Scale]

"[Limits] tab"
Double-clicking on the graph will also perform automatic scaling.

[Cursor]
[None]

Select the cursor type to display on the graph.
A normal cursor is displayed (default).
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[Crosshairs]

Displays a cursor with an intersecting vertical and horizontal line. The intersecting
point is moved in the graph view using the mouse and the coordinates are displayed
on both scales.
Configure settings such as graph line type, line color, background color, and scale
font.

[Customize]

The line type and line color settings for a 3D spectrum are valid
only at the time of change.
Settings will be reset if the cursor on the 3D graph is moved to
change the displayed spectrum portion.
"[Customize Graph] window"

[Vertical axis]

Select [Linear] or [Logarithmic] for the vertical axis of the graph.

[Properties]

Display the graph properties window. This window allows a line to be drawn at the
zero point of fluorescence intensity on the graph.

3.4.2 View Mode
The available graph views in view mode are the [Active] and [Overlay] tabs. There is one graph area on each tab.
The currently active data set is drawn on the graph area of the [Active] tab.
The spectrum data loaded from memory is drawn overlaid on the graph area of the [Overlay] tab.

Graph View (View Mode)

■Right-click menu of the graph view (view mode)
Click the right mouse button on the graph view to display the following right-click menu.
The same menu items are displayed for both the [Active] and [Overlay] tabs.
Command
[Copy]
[Picture]

Description
Copy the graph on the [Active] tab or [Overlay] tab to the clipboard.
Save a graph image in metafile format to the clipboard.
The graph can be pasted as an embedded graph object in report editing mode.

[For Report File]

An embedded graph object is an object that is not linked to the graph view
state.

Perform automatic scaling of the graph. Automatic scaling is configured on the
[Limits] tab in the [Customize Graph] window.
[Auto Scale]

"[Limits] tab"
Double-clicking on the graph will also perform automatic scaling.

[Cursor]

Select the cursor type to display on the graph.

[None]

A normal cursor is displayed (default).

[Crosshairs]

Displays a cursor with an intersecting vertical and horizontal line. The intersecting
point is moved in the graph view using the mouse and the coordinates are displayed
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on both scales.
[Surfing]

This can only be selected from the [Active] tab.
Displays a cursor with an intersecting vertical and horizontal line. The intersecting
point is moved across the active graph using the mouse and the coordinates are
displayed on both scales.

[Lock Cursor]

Fix the position of the cursor in the graph view.

[Customize]

Configure settings such as graph line type, line color, background color, and scale
font.
"[Customize Graph] window"

[Vertical axis]

Select [Linear] or [Logarithmic] for the vertical axis of the graph.

[Print]

Perform a quick print.
Set the report file to use via [User Setting] on the [Tools] menu.
"[Quick Print] tab"

[Properties]

Display the graph properties window. This window allows a line to be drawn at the
zero point of fluorescence intensity on the graph.

3.5 Data Processing View
"8 Data Processing"

This view is displayed in view mode.
The displayed tables and items differ depending on the type of the selected data processing. The [Active] and
[Overlay] tabs also change in the graph view according to the type of data processing.
Because table data created in data processing can be copied or saved as text, table data can be inserted into report
files as objects.

■Data processing that changes the display to the [Active] tab
Item

Description

[Peak Pick]

This function detects all of the peaks and valleys contained in spectrum data and
displays the results as a peak pick table. This table displays the wavelength and
fluorescence intensity corresponding to each peak and valley.

[Point Pick]

This function creates a point pick table that displays fluorescence intensities at the
specified wavelengths.

[Peak Area]

This function calculates the area of the region enclosed by the specified wavelength
range and data curve (region below the data curve).
Adding a calculation region automatically displays the calculated area value in the
area calculation table and displays the region on the graph. Multiple regions can be
specified with respect to a single data set.

[Manipulate]

This function creates a new data set by performing data set calculations, data
transformation, and arithmetic with respect to any spectrum data.

■Data processing that changes the display to the [Overlay] tab
Item

Description

[Data Print]

This function displays the fluorescence intensity of each data point in time course data
in the data print table. This table displays the spectrum data displayed on the
[Overlay] tab.

[Batch Point Pick]

This function creates a batch point pick table by detecting the fluorescence intensity at
any wavelength from all of the spectrum data displayed on the [Overlay] tab.
The results in the batch point pick table can also be updated to the point pick result of
each data set.
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